Was ist ein

Rxmmm  ARDUINO ARDUINO ?

N
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Eine quelloffene Elektronik-

L | ‘ »
o Prototypen-Entwicklungs-
Q Q - : Plattform.
?
u - & Aber was soll das bedeuten:

Quelloffene -
Elektronik -

Prototypen -

Plattform -

Die Hard- und Softwarekomponenten eines Produkts diirfen kostenlos genutzt,
verdndert und weiter verbreitet werden.

Technologie, welche sich die physikalischen Eigenschaften von Elektronen
in Leiterbahnen zu Nutze macht.

Probemodell eines Gerdts fir die Serienproduktion.

Eine Ansammlung von passender Hardware und Software, die einem das
Ausfiihren eigener Programme ermdglicht.
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Ein Arduino ist ein Mikrocontroller, ein sehr kleiner Computer, den man dazu bringen kann, auf Geschehnisse zu
reagieren. Er kann Sachen messen (z.B. wie hell ein Raum gerade ist). Und er kann dann andere Dinge dazu bringen
auf diese Verdnderungen zu reagieren. (z.B. der Raum wird dunkel und eine LED geht an).

Bei PCs sind Maus und Tastatur e Eree e
An — — Aus die klassischen Eingabegerdte. //’
—~~ L — Die Bildschirmanzeige ist eine ,

Ausgabemethode.

T | Mikrocontroller arbeiten wie Computer mit Ein- und Ausgaben.
Eingaben kannen vom Benutzer gemacht werden oder aus der

Oder er konnte auf so einfache Sachen wie Umgebung abgelesen werden. Ausgaben kénnen Warnténe sein,
das Umlegen eines Schalters reagieren. mit denen auf die gesammelten Informationen reagiert wird.




n

Auf Druck
reagierender
Widerstand

v

Tastschalter

Gleichstrom-Motor

Einen Schalter oder einen Messfiihler kann man als
Eingabegerdt fiir den Arduino nutzen.

Jedes Gerdt, welches man an- und abstellen kann, wadre
als Ausgabegerdt geeignet. Man konnte einen Motor
oder sogar einen Computer verwenden.

Was ist der Unterschied
zwischen digitalen und
analogen Ein- und
Ausgdngen?

Eingdnge und Ausgdnge konnen digital oder analog sein..
Digitale Informationen sind bindr. Wahr oder Falsch.
Analoge Informationen sind kontinuierlich und haben
unendlich viele Zwischenstufen

Digitale Informationen
sind diskret und
endlich. Sie konnen
sich nur in zwei
Zustdnden befinden: 1
oder O, An oder Aus.

Analoge Informationen
sind kontinuierlich. Sie
konnen eine unendlich
groBe Anzahl
verschiedener Werte
annehmen.

{2}

Ein Tastschalter ist d}gital. Ein Messfihler ist analog.
Die Anzahl der Zwischenstufen des Fiihlers wird
jedoch durch die Umwandlung in digitale Daten endlich.




Spannung?
Stromstadrke?
Widerstand?
Das Ohmsche
Gesetz?

£

Spannung (V)

ist eine
Masseinheit fiir

Stromstdrke (T)

Stromstadrke ist
die Flussmenge

Widerstand (R)

misst wie stark
sich ein

elektrisches durch ein _
Potenzial . leitendes llv?;:zr;?jng:;
Gemessen wird Material. Sie !
sie in der elektrischen Fluss

wird in Ampere

[A] gemessen. entgegenstellt.

Gemessen in
Ohm [0Q].

Einheit Volt [V].

4

Bevor wir den Arduino anschliefen
sollten wir uns noch mit weiteren
Begriffe und Prinzipien befassen,

die uns zeigen, wie Elektrizitdt und

somit Elektronik funktioniert. Elektrizitdat ist der Fluss von Energie durch ein leitendes Material.

SN\ j]]

Die Flussgeschwindigkeit wird durch . 57
die Spannung bestimmt. /-\
Widerstand ldsst Fluss zu
oder behindert ihn. =

Die Menge des Flusses durch die
Leitung ist die Stromstdrke.

Die Wasser-Analogie wird hdufig genutzt, um die Begriffe zu erkldren.




Das Ohmsche Gesetz

Stromstdrke = Spannung / Widerstand
(I=U/R)

Widerstand = Spannung / Stromstdrke
(R=U/T)

Spannung = Widerstand * Stromstdrke
(U=R*TI)

Es gibt einige Zusammmenhdnge zwischen Spannung,

Ein Beispiel: Erhoht man

Stromstdrke und Widerstand, die vom deutschen den Widerstand, so Erhéht man das Potenzial,
Physiker Georg Ohm entdeckt wurden. fliesst weniger Wasser so fliesst mehr Wasser.
Lampe l
| I — Gleichstrom-
‘7 Schalter —  quelle
+

Schauen wir uns nun eine einfache Schaltung an. Jede
Schaltung ist ein geschlossener Kreislauf, der eine
Energiequelle (Batterie) und eine Last (Lampe)
beinhaltet. Die Last wandelt die Energie in Licht. Ein
Schalter wurde hier auch verbaut.

Dies ist der Schaltplan der einfachen Schaltung. Die
Schaltung wird hier reprdsentiert, indem S\X/mbole
anstatt der Komponenten gezeigt werden. Wenn der
Schalter geschlossen wird, fliesst Strom zwischen den
Polen der Energiequelle und erleuchtet die Lampe.
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Es gibt zwei Arten von Schaltungen. Gleichstrom- und
Wechselstromschaltungen. Bei einer Gleichstrom-
Schaltung fliesst der Strom immer in eine Richtung. Bei
einem Wechselstromkreis kehrt sich der Stromfluss
regelmdBig in die enfgegeraesetzfe Richtung. Wir
interessieren uns nur fur Gleichstromschaltungen.

Der Arduino en.c'j’ri‘r wie ade_r‘g ele .
nung zum Arbeiten, und da wir ihn jetzt programmieren
mo

DIGITAL (PWM~)

Jetzt wo wir die Grundsdtze der

Elektrizitdt aufgefrischt haben
konnen wir uns wieder dem _

Arduino zuwenden.
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)Chten, schliessen wir ihn an den Computer an.

Wenn wir den Arduino mit einem USB-Kabel an einen
Computer anschliessen wird er liber das Kabel mit den
benotigten 5 Volt versorgt, und wir konnen loslegen.

ADNIITNO

Die Software gibts hier: u

http://arduino.cc/de/Main/Software

(MITELEEY 'O e rite 2 Seadu 1 1

P OUEY e Auu il

Vorher musst du jedoch noch die kostenlose Software
von obiger Adresse herunterladen und installieren. Die
Arduino Software lauft auf den folgenden gdngigen
Plattformen: Mac OSX, Windows und Linux




auf einem Mac:

auf einem Windows-PC:

auf einem Linux-System:

Wenn du Hilfe benotigst bei der Installation

http://www.arduino.cc/en/Guide/MacOSX
Wenn du Hilfe benotigst bei der Installation

http://www.arduino.cc/en/Guide/Windows
Wenn du Hilfe benotigst bei der Installation

http://www.arduino.cc/playground/Learning/Linux

die Software-Installation benotigst.

Besuche die obigen Adressen, wenn du detaillierte Anleitungen fiir

Wenn du die Software installiert hast und
der Arduino angeschlossen wurde, sollte eine
mit ON beschriftete LED aufleuchten.

B b e
®T

Auto Format

Archive Sketch

Fix Encoding & Reload "
Serial Monitor {186

ino Uno
g ., Arduino milanove W/ ATmega328

rd ino Due . egd
a\ Port > ':';33::2 Diecimila or Duerr;\zasnove w/ ATmeg
. Tmega
> Arduino Nano w/ A
mer 168
A tloader Arduino Nano w/ ATme&a 2 ADK
M/’W Arduino Mega 2560 or Med

Arduino Mega {ATmegalZSz(:a}
Arduino Mini w/ Iﬂ’me.g\a?;ﬁ8
Arduino Mini w/ ATmegal
Arduino Ethernet

i io
Arduino i L ATenana3?8

Nun Starte die Arduino-Software. Im Menii Tools wdhle
aus, welches Board du benutzt (Tools > Board). Zum
Beispiel Arduino UNO.

it Burn Bootloader

Help
Auto Format
Archive Sketch

Fix Encoding & Reload
Serial Monitor +3#EM

Board >
Serial Port

#T

/dev/tty.ushmodem1a21
/dev/cu.usbmodemla2]
/dev/tty.Bluetooth-Modem
/dev/cu.Bluetooth-Modem
/dev/tty Bluetonth-PNA Cwe

Programmer >

Als ndchstes muss man den seriellen Port auswdhlen

(Tools > Serial Port). Auf einem Mac sucht man z.B.
nach /dev/tty.usbmodem, unter Windows vielleicht

nach COM3. Hadufig ist es der Eintrag, der nach dem
Einstecken des Kabels zur Liste hinzukommt.




Was ist eine
integrierte
Entwicklungs
Umgebung ?

Englisch:
Integrated

Development
Environment

o

Die Software, die du heruntergeladen
hast, ist eine IDE. Das ist ein
Texteditor mit dem man Programme
kompilieren kann sowie weiteren
Funktionen, die es einem erleichtern,
Software zu entwickeln.

Arduino lag Edit Sketch Tools Help
New N Arduino 1.0
Open... #0

Sketchbook
Examples

»

> Analo

S?Iose #W  2.Digital > BareMgiJ
K Save A 3#S 3.Analog >
s on an Ua\.lfe ds... 365 4.Communication > DigitalR

ploa ‘ kU 5.Control 2 Fade

cxanple  Upload Using Programmer £+ 32U b.Sensors L

Page Setup omp  Display >

Print 3p 8.5trings >

ArduinolSP

EEUDC) ommmmmeee——— T
Nitialize the Ainital miw oo an oo
Die Arduino IDE ermadglicht es dir, Sketche, das sind kleine Programme,
zu schreiben und sie auf den Arduino hochzuladen. Offne das Blink -
Beispielprogramm im File-Mend. File > Examples > 1.Basics > Blink.

Upload

Upload-Knopf

ledPin = 13

() o

(ledPin, OUTPUT);

L) L

"Done Uploading" zu lesen sein.
9

Um einen Sketch zum Arduino Mikrocontroller hochzu-
laden klick den Upload-Knopf in der Knopfleiste im
oberen Teil des Fensters. Unten werden einige
Nachrichten erscheinen. Schlussendlich sollte

Die LED am Pin 13 vom Arduino fangt an zu blinken.




void setup() {
// initialize the digital pin as an output.
// Pin 13 has LED connected on most Arduino boards
pinMode (13, OUTPUT);

}

void loop() {
digitalWrite(13, HIGH); // set the LED on

delay(1000); // wait for a second

digitalWrite(13, LOW); // set the LED off

delay(1000); // wait for a second
}

Ein Sketch ist, genauso wie jedes andere Programm
auch, eine Menge von Anweisungen fiir den Computer.
Wenn wir uns den Blink-Sketch genauer ansehen, so
konnen wir feststellen, dass er aus zwei grofieren
Teilen besteht: setup() und loop().

setup(): Wird einmal ausgefihrt
beim Programmstart

/} loop(): Wird immer wieder und

wieder ausgefihrt

Diese Code-Blocke heissen Funktionen und jeder
Sketch hat welche. Sie werden durch geschweifte
Klammern { } begrenzt.

http://arduino.cc/en/Reference/HomePage

|_Language Reference |

—

Besuch' spdter mal die Arduino Webseite um eine
Referenz der Sprache zu sehen sowie viele andere
Resourcen zum Erlernen der Sprache.

void setup() { // Deklariert einen Code-Block
pinMode (13, OUTPUT); // Setzt Pin 13 auf Ausgabe
} // Ende des Code-Blocks
void loop() { // Deklariert einen Code-Block
digitalWrite(13, HIGH); // Schaltet Pin 13 an
delay(1000); // Pause fiir eine Sekunde
digitalWrite(13, LOW); // Schaltet Pin 13 ab
delay(1000); // Pause fir eine Sekunde
} // Ende des Code-Blocks

Jetzt aber schau dir Zeile fiir Zeile das Skript an und
sehe in den Kommentaren, was jede Zeile macht.




Aber wie konnen wir Objekte steuern, die nicht auf dem
Arduino sind? Daflr verbinden wir den Arduino mit
einem l6tfreien Experimentier-Steckbrett. Damit
konnen wir blitzschnell Testschaltungen aufbauen.

\ Locher untereinander
horizontal verbunden

Lécher untereinander
|_—~ vertikal verbunden

Dieses Steckbrett hat je zwei Reihen mit Lochern auf
der linken und rechten Seite, die vertikal miteinander
verbunden sind sowie fiinf Spalten links und rechts der
kleinen Vertiefung in der Mitte. Diese sind horizontal
miteinander verbunden.

Wir verbinden 5V (Potential/+Pol) und GND (Masse/
Erde) vom Arduino mit den vertikal verbundenen
Streifen links und rechts des Brettes mit 0,7mm
dickem Draht. Elektronische Bauelemente konnen jetzt
an die Locher in der Mitte sowie an 5V und GND

Anode

(an 5V an-

schliessen)
Kathode
(an 6ND an- Merke:
schliessen) Kurz wie Kathode

angeschlossen werden.

Wenn Strom durch eine LED (Licht emittierende
Diode) in der richtigen Richtung fliesst, dann leuchtet
sie auf. Wir stecken eine LED auf das Experimentier-
brett. Dann legen wir Leitungen zum Arduino, so dass
wir die LED mit Code steuern kdonnen.




P void setup() {

L ZZLRIZT S8 ; pinMode(2, OUTPUT); }
void loop() {

: digitalWrite(2, HIGH);
: = delay(500);

L) digitalWrite(2, LOW);
o~ o~ ' delay(500); }
ONN: (X2
e S St BE i8¢ In der Funktion setup() konfigurieren wir Pin 2
als Ausgabe. In loop() setzen wir Pin 2 auf

HIGH, was die LED leuchten lasst. Del t
Die Anode wird mit Pin 2 am Arduino liber einen 220 Ohm fiir emew Szusfvon 5g(t)jcMi|Tirs‘e?<iidene(gySZ?<{ﬂ)g

Widerstand verbunden. Die Kathode wird mit GND verbunden. Die Wenn Pin 2 auf LOW gesetzt wird, geht die
Pins 2 bis 13 konnen als digitale Ein- oder Ausgdnge konfiguriert LED aus. Dann folgt eine weitere L Sek. Pause
werden. Klick auf den Neu Knopf um einen neuen Sketch zu machen. ' 9 e '

Upload-Knopf

Klicke den Verify-Knopf im Menii, um deinen Code priifen| |Die LED leuchtet fir eine halbe Sekunde, dann ist sie
zu lassen. Wenn es keine Fehlermeldung gab, klicke auf fiir eine halbe Sekunde aus. So blinkt sie immer wieder
Upload, um dein Programm auf den Arduino zu und wieder.
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Verbinde den einen Kontakt des Tasters mit Pin 4 am Arduino. Den-

Als ndchstes fiigen wir dem Ganzen einen selben Kontakt des Schalters schliessen wir an Erde liber einem 10
digitalen Schalter hinzu, so dass wir die Kilo-Ohm Widerstand an. Die andere Seite des Schalters soll mit
LED An- und Ausschalten konnen. 5V verbunden werden. Die LED lassen wir wo sie ist.

void setup() {
pinMode(2, OUTPUT);
pinMode(4, INPUT);

}

void loop() {
if(digitalRead(4)){
digitalWrite(2, HIGH);
Yelse{
digitalWrite(2, LOW);
}
}

Jetzt schreiben wir den Code. In Setup definieren wir
Pin 2 als Output und Pin 4 als Input. Im Loop benutzen
wir eine if-Anweisung, eine Bedingung. Wenn das Signal
an 4 HIGH ist, setzen wir den LED-Pin HIGH, ansonsten
setzen wir ihn auf LOW und schalten die LED somit ab.

4.

«

Die LED leuchtet, wenn der Schalter gedriickt wird.




Ein Potentiometer, auch Poti
genannt, ist ein verdnderlicher
Widerstand. Die 6rofe des
Widerstandes wird grofer oder
kleiner je nachdem in welche
Richtung er gedreht
wird.
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Lass uns mal ein analoges Eingabegerdt
ausprobieren, das Potentiometer.

Schliesse den mittleren Pin des Potis an den Analogpin AO an. Die anderen
Anschliisse des Potentiometers miissen auf GND und 5V gelegt werden.
So gibt der Mittelpin Teilspannungen zwischen O und 5V aus.

void setup() {
Serial.begin(9600);

}

void loop() {
Serial.println(analogRead(AQ));

}

Erstmal sehen wir uns die unterschiedlichen Werte, die
wir durch das Drehen des Potis erhalten, mit Hilfe des
Seriellen Monitors an. Im Code initialisieren wir dafir
die serielle Schnittstelle und setzen sie auf eine
Geschwindigkeit von 9600 Baud. Im loop lesen wir den
Wert von Analog Pin AO und geben ihn zur Ausgabe an
die Serielle Schnittstelle mit der println - Funktion.

129 Klicken um den seriellen
131 Monitor zu 6ffnen

153

Nachdem du den Sketch auf den Arduino hochgeladen
hast, klicke auf den Knopf fiir den Seriellen Monitor um
die Werte sehen zu konnen. Ein Fenster wird sich
offnen und du wirst Werte von O bis 1023 sehen, je
nach dem wohin du das Potentiometer gedreht hast.
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0% Duty Cycle - analogWrite(0)

5v |

OV 1 1 1
50% Duty Cycle - analogWrite(127)

ol L]
100% Duty Cycle - analogWrite(255)
5v
X1 1 1 ‘.‘3
ol | [

Wir werden die PulsWeitenModulation
nutzen, um Analogspannungen zu simulieren.
Durch das An- und Abschalten der

-
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Wir konnten die wechselnden Werte, die wir vom Poti empfangen,
nutzen, um eine LED zu dimmen. Steck die LED zuriick ins Brett

und verbinde sie mit dem Arduino uber Pin 3.

Spannung mit unterschiedlichen Perioden
kann die LED 0-100% der Zeit an sein. PWM
funktioniert auf Pins 3,5, 6,9, 10 und 11

int sensorValue = 0;

void setup() {
hinMode(3,0UTPUT);

void loop() {
sensorValue = analogRead(A0);
analogWrite(3, sensorValue/4);

Zundchst erstellen wir eine Variable, um den Wert des
Potis zu speichern. In setup konfigurieren wir Pin 3 fir
Ausgabe. In loop speichern wir den Wert, den wir von
AO gelesen haben, in unserer Variable. Dann schreiben
wir den Wert auf Pin 3 (LED), miissen ihn vorher aber
noch durch 4 teilen, damit er zwischen O und 255 liegt.
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Die Helligkeit der LED ldsst sich jetzt von komplett
aus bis sehr hell dndern, je nach dem wie du den Poti
einstellst.




Das war eine kurze
Einfihrung in die
Mikrocontroller-

programmierung mit

Arduino. Besuch die Links

in den ndchsten Kdsten

und du wirst noch viel
mehr erfahren.

Links

Software
Software Download
http://www.arduino.cc/en/Main/Software
Referenz der Sprache

http://arduino.cc/en/Reference/HomePage
Bezugsquellen
Distributorenliste
http://arduino.cc/en/Main/Buy
TinkerSoup
http://www.tinkersoup.de/index.php?cPath=22
Watterott

http://www.watterott.com/de/Boards-Kits/Arduino
Elektronikladen
http://elmicro.com/de/arduino.html

Tutorials
Arduino Tutorials

www.arduino.cc/playground/Deutsch/HomePage
Lady Ada

www.freeduino.de/books/arduino-tutorial-lady-ada
Mehr Deutsche Tutorials
www.freeduino.de/books/
Bucher
Die elektronische Welt mit Arduino entdecken
Erik Bartmannn
Arduino - Physical Computing fir Bastler, Designer
und Geeks Verlag: O'Reilly

Make: Elektronik: Lernen durch Entdecken
Charles Platt
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